
NEWSLETTER #73 - December 2018

So as we bid “adieu” to 2018 we say “hello”  
to 2019 – that’s Excel 2019.  We mentioned it was Commercially Available last time out: this time we 
take a look at it in detail.

But of course, that’s not all.  We look at Excel operators as we still reveal the latest update news, plus continue our 
regular series on Power Query, VBA, Keyboard Shortcuts and the ever-continuing A to Z of Excel Functions.  

Season’s greetings to you all.

Last month we mentioned Office 2019 was now Commercially Available.  We thought we’d better do some digging and see what was new (compared 
to Excel 2016, rather than Office 365).  There really wasn’t any room in last month’s newsletter, so please forgive our tardiness.  However, we aim 
to put it right now!

Yes, we know we’ve done this before but for completeness, there are six new functions in Excel 2019 (compared to Excel 2016).  These comprise:

	 •	 IFS
	 •	 SWITCH
	 •	 CONCAT
	 •	 TEXTJOIN
	 •	MAXIFS
	 •	MINIFS.

Let’s go through them.

IFS

As model developers and reviewers, we must confess we remain unconvinced about this one.  If you have ever used a formula with nested IF	
statements, e.g.

=IF(IF(IF…

then maybe this function is for you – however, if you have ever written Excel formulae like this, then maybe Excel isn’t for you!  There are usually 
better ways of writing the formula using CHOOSE or INDEX(MATCH) (see www.sumproduct.com/thought/index-match.html for more) for example.  

The syntax is as follows:

IFS(logical_test1,	value_if_true1,	[logical_test2,	value_if_true2],	[logical_test3,	value_if_true3],…)

where:

 •	 logical_test1	is a logical condition that evaluates to TRUE or FALSE;

	 •	 value_if_true1 is the result to be returned if	logical_test1 evaluates to TRUE.  This may be empty

	 •	 logical_test2 (and onwards) are further conditions that evaluate to TRUE or FALSE also

	 •	 value_if_true2 (and onwards) are the respective results to be returned if the corresponding logical_test evaluates to TRUE.   
  Any or all may be empty.

Since functions are limited to 254 arguments (sometimes known as parameters), the new IFS function can contain 127 pairs of conditions and results.

What’s New in Excel 2019

contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

www.sumproduct.com  |  www.sumproduct.com/thought

Liam Bastick, Managing Director, SumProduct

New Functions

http://www.sumproduct.com/thought/index-match.html
mailto:contact@sumproduct.com
http://www.sumproduct.com


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

One thing to note is that IFS is not quite the same as IF.  With the IF statement, the third argument corresponds to what do if the logical_test is not 
TRUE (i.e. it is an ELSE condition).  IFS does not have an inherent ELSE condition, but it can be easily generated.  All you have to do is make the final 
logical_test equal to a condition which is always true such as TRUE or 1=1 (say).  

Other issues to consider:

 • Whilst the value_if_true may be empty, it must not be omitted.  Having an odd number of arguments in an IFS statement would give rise to  
  the “You’ve entered too few arguments for this function” error message.

 • If a logical_test is not actually a logical test (e.g. it evaluates to something other than TRUE or FALSE, the function returns an #VALUE! error.   
  Numbers still appear to work though: any number than zero evaluates as TRUE and zero is considered to be FALSE.

 • If no TRUE conditions are found, this function returns the #N/A! error.

To show how it works, consider the following example.  

Here, would-be gurus are graded based on evaluation criteria in the table, applied in a particular order:

=IFS(H13="Yes",I13,H14="Yes",I14,H15="Yes",I15,H16="Yes",I16,TRUE,"Not a Guru")

I think it’s safe that although it is reasonably straightforward to follow, it is entirely reasonable to say it’s not the prettiest, most elegant formula 
ever put to Excel paper.  In particular, do pay heed to the final logical_test: TRUE.  This ensures we have an ELSE condition as discussed above.

To be fair, one similar solution using legacy Excel functions isn’t any better:

=IF(H13="Yes",I13,IF(H14="Yes",I14,IF(H15="Yes",I15,IF(H16="Yes",I16,"Not a Guru"))))

Lovely.

SWITCH

SWITCH is already available in many alternative programming languages and can simplify potentially horrible formulae.  This function evaluates an 
expression against a list of values and returns the result corresponding to the first matching value.  If there is no match, an optional default value 
may be returned.  The syntax is as follows:

SWITCH(expression, value1, result1, [default or value2, result2],…[default or valueN, resultN])

where:

 • expression is the value that will be compared against the values (value1 to valueN) cited

 • value1 to valueN are the values that will be compared against the expression

 • result1 to result are the values, references or formulae results to be returned when the corresponding valueN argument matches the  
  expression.  The result must be supplied for each corresponding valueN argument

 • default is an optional value to return in case no matches are found in the valueN expressions.  The default argument is identified by having  
  no corresponding result expression, i.e. it must be the final argument in the function where the function contains an odd, rather than an  
  even, number of arguments.  If no default argument is supplied and no match is found this function returns the #N/A! error.

To illustrate, consider the following painful formula:

=SWITCH(MID($G13,SEARCH("-",$G13)+1,SEARCH("-",$G13,(SEARCH("-",$G13)+1))-SEARCH("-",$G13)-1),"XS","Extra Small","S","Small","M","M
edium","L","Large","XL","Extra Large","Not Specified")
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The expression here is 

MID($G13,SEARCH("-",$G13)+1,SEARCH("-",$G13,(SEARCH("-",$G13)+1))-SEARCH("-",$G13)-1)

which is determining what is contained between the two hyphens (for more on text string functions, please see www.sumproduct.com/thought/
text-messages.html).  It is horrible, and that’s the point.  The formula then considers what the values may be (“XL”,”M”) and what value should be 
returned as a consequence (“Extra Large”, “Medium”).

The corresponding Excel formula before SWITCH would have been a nightmare:

=IF(MID($G13,SEARCH("-",$G13)+1,SEARCH("-",$G13,(SEARCH("-",$G13)+1))-SEARCH("-",$G13)-1)="XS","Extra Small",
IF(MID($G13,SEARCH("-",$G13)+1,SEARCH("-",$G13,(SEARCH("-",$G13)+1))-SEARCH("-",$G13)-1)="S","Small",
IF(MID($G13,SEARCH("-",$G13)+1,SEARCH("-",$G13,(SEARCH("-",$G13)+1))-SEARCH("-",$G13)-1)="M","Medium",
IF(MID($G13,SEARCH("-",$G13)+1,SEARCH("-",$G13,(SEARCH("-",$G13)+1))-SEARCH("-",$G13)-1)="L","Large",
IF(MID($G13,SEARCH("-",$G13)+1,SEARCH("-",$G13,(SEARCH("-",$G13)+1))-SEARCH("-",$G13)-1)="XL","Extra Large","Not Specified")))))

CONCAT

This function replaces the CONCATENATE function (see www.sumproduct.com/thought/concatenation.html).  The CONCAT function combines the 
text from multiple ranges and / or text strings:

CONCAT(text1, [text2],…)

where:

 • text1 is the text item to be joined

 • text2 (onwards) are the additional items to be joined.

For example, consider the following illustration:
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Upon first glance, CONCAT does the same thing as the legacy CONCATENATE function or & (ampersand) operator, but is just easier to spell.  However, 
it is a little more than that: CONCATENATE will not cope with highlighting a contiguous range (it will just return the #VALUE! error); CONCAT will 
concatenate them all.

Here, in the formulae on rows 53 and 54, empty cells in a contiguous range may be ignored and delimiters only need to be specified once.  When you 
compare to CONCAT, you do begin to wonder why you need it – perhaps to soften the demise of CONCATENATE..?

TEXTJOIN

The TEXTJOIN function combines the text from multiple ranges and / or text strings and includes a delimiter to be specified between each text value 
to be combined. If the delimiter is an empty text string, this function will effectively concatenate the ranges similarly to the CONCAT function.  Its 
syntax is

TEXTJOIN(delimiter, ignore_empty, text1, [text2], …)

where:

 • delimiter is a text string (which may be empty) with characters contained within inverted commas (double quotes).  If a number is supplied, it  
  will be treated as text

 • ignore_empty ignores empty cells if TRUE or the argument is unspecified (i.e. is blank)

 • text1 is a text item to be joined

 • text2 (onwards) are additional items to be joined up to a maximum of 252 arguments.  If the resulting string contains more than 32,767  
  characters TEXTJOIN returns the #VALUE! error.

TEXTJOIN is more powerful than CONCAT.  To highlight this, consider the following examples:

MAXIFS and MINIFS

The last two new functions I am going to combine – and 
not with TEXTJOIN!  

MAXIFS(max_range, criterion_range1, criterion1, 
[criterion_range2, criterion2], ...)

returns the maximum value among cells specified by a 
given set of conditions or criteria, where:

 • max_range is the actual range of cells in which the   
  maximum is to be determined

 • criterion_range1 is the set of cells to evaluate with   
  the criterion specified

 • criterion1 is the criterion in the form of a number,   
  expression or text that defines which cells will be   
  evaluated as a maximum

 • criterion_range2 (onwards) and criterion2 (onwards)  
  are the additional ranges and their associated criteria.   
  126 range / criterion pairs may be specified.   
  All ranges must have the same dimensions otherwise  
  the function returns an #VALUE! error.

MINIFS behaves similarly but returns the minimum rather 
than the maximum value among cells specified by a given 
set of conditions or criteria.
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This example is preferable to its standard Excel counterpart:

{=MAX(IF(G13:G31=H34,IF(H13:H31=H35,IF(I13:I31=H36,J13:J31))))}

Array formulae (see www.sumproduct.com/thought/array-of-light.html for more information) are cumbersome and not readily understood.

You can create a map chart to compare values and show categories across geographical regions.  This may be used when you have geographical 
regions in your data, like countries / regions, states, counties or postal codes.

You can now insert what are known as Scalable Vector Graphics (SVG) files into not just Excel but any of your Microsoft Office documents, workbooks, 
emails and presentations.  Once they're in place, they are easy to rotate, colour, filter and resize with no loss of image quality.  To insert:

 • Insert an SVG file in Office for Windows: simply drag and drop the file from Windows File Explorer into your document

 • Insert an SVG file in Office for Mac: Go to Insert > Pictures > Picture from file to insert your SVG images.

Funnel charts show values across multiple stages in a process.  For example, you could use a funnel chart to show the number of sales prospects at 
each stage in a sales pipeline.  Typically, the values decrease gradually, allowing the bars to resemble a funnel.

New Charts

Enhanced Visuals
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Further, you may transform all SVG pictures and icons into Office shapes so you can change their colour, size or texture:

You can insert 3D models into your Excel files much the same way as other images.  On the ‘Insert’ tab of the Ribbon, select 3D ‘Models’ and then 
‘From a File’:

You can use 3D to increase the visual and creative impact of your, so that images may be rotated through 360 degrees.
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We can’t say we use these features much in financial modelling, but some of you out there may.  Inking features were initially introduced in Office 
2016, but there have been improvements made in the 2019 counterpart:

	 •	 New	ink	effects: you can now express your ideas using metallic pens and ink effects like rainbow, galaxy, lava, ocean, gold, silver and more

	 •	 Digital	Pencil: you may write or sketch out ideas with the new pencil texture

	 •	 Customisable,	portable	pen	set: It’s now possible to create a personal set of pens to suit your needs.  Office remembers your pen set in  
  Word, Excel and PowerPoint across all of your Windows devices

	 •	 Ink	equations:	including mathematical equations is now easier – simply go to Insert	>	Equation	>	Ink	Equation, any time you want to include  
  a complex maths equation in your workbook.  If you have a touch device, you can use your finger or a touch stylus to write math equations  
  by hand and Excel will convert it to text. (If you don't have a touch device, you can use a mouse to write, too.)  You may also erase, select and  
  correct what you've written as you go

	 	 Note	to	Microsoft:	it’s	“Maths”…

	 •	 New	Ink	Replay	button:	if	you	are	using	ink	in	your	spreadsheets,	you	can	now	replay	or	rewind	your	ink	to	better	understand	the	flow	of	it.			
	 	 This	offers	an	alternative	to	GIF	images	to	provide	get	step-by-step	instructions.		You'll	find	‘Ink	Replay’	on	the	‘Draw’	tab

	 •	 Lasso	Select	at	your	fingertips:	Excel	now	has	Lasso	Select												,	a	free-form	tool	for	selecting	ink.		Drag	with	the	tool	to	select	a	particular		
	 	 area	of	an	ink	drawing,	and	then	you	can	manipulate	that	object	as	you	wish

	 •	 Convert	ink	drawing	to	shapes:	the	‘Draw’	tab	lets	you	select	inking	styles	and	start	making	ink	annotations	on	your	touch-enabled	device.			
	 	 You	may	also	convert	those	ink	annotations	to	shapes.		Just	select	them	and	then	select	‘Convert	to	Shapes’.		That	way,	you	get	the	freedom		
	 	 of	freeform	drawing	with	the	uniformity	and	standardisation	of	Office	graphic	shapes

	 •	 Use	your	Surface	pen	to	select	and	change	objects:	Well	that	assumes	you	have	a	Surface!		In	Excel,	with	a	Surface	pen,	you	can	select		
	 	 an	area	without	even	tapping	the	selection	tool	on	the	Ribbon.		Just	press	the	barrel	button	on	the	pen	and	draw	with	the	pen	to	make	a		
	 	 selection.	Then	you	can	use	the	pen	to	move,	resize	or	rotate	the	ink	object.	

Ink Improvements
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Before sharing your spreadsheet, in Excel 2019 you can run the ‘Accessibility Checker’ to ensure your content is easy for people of all abilities to read 
and edit.  On the Ribbon, click the ‘Review’ tab and then click ‘Check Accessibility’:

You can now attach hyperlinks to recent cloud-based files or websites and create meaningful display names for people using screen readers.  To add 
a link to a recently used file, on the ‘Insert’ tab, choose ‘Link’ and select any file from the displayed list.

This will provide review results.  You may see a list of errors, warning, and tips with how-to-fix recommendations for each.  Excel 2019 now offers 
one-click fixes and is better than ever with updated support for international standards and handy recommendations to make your documents more 
accessible for all users.

Helpful sounds improve accessibility, but be careful: when you make changes to settings, the option affects all Microsoft Office programs that support 
this.  Having said that, you can turn on audio cues to guide you as you work.

In the ‘File’ menu, select ‘Options’ (ALT + T + O).  On the ‘Ease of Access’ tab, under ‘Feedback Options’, select or clear the ‘Provide feedback with 
sound checkbox’.  If you wish, you can use the original Office sound effects by selecting the ‘Classic theme’ from the ‘Sound Theme’ drop-down.

Better Accessibility Features

Sharing and Saving
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That’s not all.  You may also view and restore changes in workbooks that are shared.  You can now quickly view who has made changes in workbooks 
that are shared, and easily restore earlier versions. 

Microsoft Office automatically saves versions of your SharePoint, OneDrive and OneDrive for Business files while you’re working on them (we have 
covered this before and not necessarily favourably!).  These versions allow you to look back and understand how your files evolved over time and 
allow you to restore older versions in case you have made a mistake.

Version history in Office only works for files stored in OneDrive or SharePoint Online.  If you don't see this option it's possible your file is stored in a 
different service or on a local device.  To view historical versions:

 1. Open the file you were working on

 2. Click the File > Info and select ‘View and restore previous versions’ 

With the version you want to restore open in your application, click ‘Restore’ in the message bar at the top of the opened version.  Restore will save 
your current file as a new version and then replace your current file with the contents of the version you chose to restore.

You can quickly save to recent folders too.  Go to File > Save As > Recent, and you’ll see a list of recently accessed folders that you can save to.

Excel will now let you deselect cells or a range of cells from your current selection.  Microsoft has just rolled this out for PC and Mac subscription 
users of Office 365.  

To "unselect" (it's a new word, look it up!) a selected cell, hold down the CTRL button (or Command on a Mac) key and click on the cells you want to 
deselect.  To unselect a range of selected cells, hold down the CTRL (or again, the Command for Mac) key and drag the range you want to deselect, 
starting from within the selected range.

Don’t get confused with the cell in the top left-hand corner of the range selected remaining white!  You can have fun experimenting what that looks 
like when it is de-selected...

	 3.	The	‘Version	history’	tab	will	open.		Click	a	version	to	open	and	view	it	in	a	separate	window.

Selecting Only What You Want
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Now this one made me laugh.  This is apparently a new feature, but we swear you have been able to do this since the Quick Access Toolbar came out!  
You can now add these features to the Quick Access Toolbar.  Wow.

Microsoft has improved the AutoComplete functionality in that you no longer need to be so precise to find what you are looking for, e.g.

There are now three Office Themes that you can apply: Colorful (sic), Dark Gray and White.  To access these themes, go to File >Options > General, 
and then click the drop-down menu next to ‘Office Theme’.

The highest-contrast Office theme yet has arrived. To change your Office theme, go to File > Account, and then click the drop-down menu next to 
Office Theme.  The theme you choose will be applied across all your Office apps.  

Excel will now look for functions or range names that contain the phrase sought.  This will help immensely when you cannot quite remember what it 
was you are looking for.  This one is cool.

There you go.  If ever there was a business case to go out and buy Excel 2019, that certainly wasn’t it…

Quick Access to Superscript and Subscript

Improved AutoComplete

New Themes 

Black Theme 

Perfect for hangovers and for reflecting your mood when you have to work late, we originally claimed we weren’t quite sure this was going to catch 
on, but we have seen many clients adopt this.  I suppose once you go black you never go back…
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Translate words, phrase, or sentences to another language with Microsoft Translator.  You can do this from the ‘Review’ tab in the Ribbon:

Remember this warning: "This file may contain features that are 
not compatible with CSV..."?  Well, apparently no one wanted it.  So 
Microsoft has got rid of it when you save a CSV file.

Furthermore, you can now open and save CSV files that use UTF-8 
character encoding.  Go to File > Save As > Browse.  Then click the ‘Save 

as type’ menu, and you'll find the new option for ‘CSV UTF-8 (Comma 
delimited)’.  CSV UTF-8 is a commonly used file format that supports 
more characters than Excel’s existing CSV option (ANSI).  What does this 
mean in English?  Better support for working with non-English data, and 
ease of moving data to other applications.

PivotTables were enhanced beyond recognition with the advent of Excel 2010 and Excel 2013, and the introduction of Power Pivot and the Data 
Model, bringing the ability to easily build sophisticated models across your data, augment them with measures and KPIs and then calculate over 
millions of rows with high speed.  But it’s not stopped there: 

	 •	 Personalise	the	default	PivotTable	layout: you may now set up a PivotTable the way you like.  You can choose how you want to display  
  subtotals, grand totals and the report layout, then save it as your default.  This means that the next time you create a PivotTable, you will  
  start with that layout

	 •	 Automatic	relationship	detection: this feature discovers and creates relationships among the tables used for your workbook’s data model, so  
  you don’t have to.  Excel knows when your analysis requires two or more tables to be linked together and notifies you.  With one click, it does  
  the work to build the relationships, so you can take advantage of them immediately

	 •	 Creating,	editing,	and	deleting	custom	measures: this may now be done directly from the PivotTable fields list, saving you a lot of time when  
  you need to add additional calculations for your analysis

	 •	 Automatic	time	grouping:	this helps you to use time-related fields (year, quarter, month) in your PivotTable more powerfully, by auto- 
  detecting and grouping them on your behalf.  Once grouped together, simply drag the group to your PivotTable in one action and   
  immediately begin your analysis across the different levels of time with drill-down capabilities 

	 •	 PivotChart	drill-down	buttons:	this allows you to zoom in and out across groupings of time, and other hierarchical structures within your data

	 •	 Search	in	the	PivotTable: the ‘Field list’ helps you get to the fields that are important to you across your entire data set

	 •	 Smart	renaming:	this gives you the ability to rename tables and columns in your workbook’s data model.  With each change, Excel   
  automatically updates any related tables, and calculations across your workbook, including all worksheets and DAX formulae.  This is quite a  
  welcome improvement as this caused many problems in previous versions of Excel

	 •	Multi-select	Slicer: you may now select multiple items in an Excel Slicer on a touch device.  This is a change from prior versions of Excel,  
  where only one item in a Slicer could be selected at a time using touch input.  You can enter Slicer multi-select mode by using the new button  
  located in the Slicer’s label

Translator

CSV Improvements

PivotTable Enhancements
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	 •	 Faster	OLAP	PivotTables: if you work with connections to online analytical processing (OLAP) servers, your PivotTables are now faster.   
  Excel 2019 contains query and cache improvements in this powerful feature’s performance.  You could benefit from this work, whether you  
  use PivotTables to answer one-off questions, or build complicated workbooks with dozens of PivotTables.  It doesn’t matter if your   
  PivotTables are connected to a tabular or multi-dimensional model.  Any PivotTable connected to Microsoft SQL Server Analysis Services,  
  third party OLAP providers or the Power Pivot Data Model will likely give you fresh data, faster.  Additionally, now if you disable Subtotals and  
  Grand Totals, PivotTables can be much faster when refreshing, expanding, collapsing, and drilling into your data.  The bigger the PivotTable,  
  the bigger the potential improvement.  Specifically, Excel 2019 offers improvements in three major areas while querying OLAP servers:

   o Improved	query	efficiency: Excel will now query for Subtotals and Grand Totals only if they’re required to render the PivotTable  
    results.  This means you wait less for the OLAP server to finish processing the query and you wait less while waiting for the results  
    to transfer over your network connection.  You simply ‘disable Subtotals and Grand Totals’ from the ‘PivotTable Design’ tab just like  
    you would normally 

   o Reduced	the	number	of	queries:	Excel is smarter when refreshing your data.  Queries will now only refresh when they’ve actually  
    changed and need to be refreshed

   o Smarter	caches: when the PivotTable schema is retrieved, it is now shared across all of the PivotTables on that connection, further  
    reducing the number of queries.

Power Pivot gets a dusting down in Excel 2019 too:

  • Save relationship diagram view as picture: you may now save the data model diagram view as a high resolution image file that can then be  
  used for sharing, printing or analysing the data model.  To create the image file, in the ‘Power Pivot’ pane, click File > Save View as Picture

 • Multiple usability improvements: these have also been made.  For example, delayed updating allows you to perform multiple changes  
  in Power Pivot without the need to wait until each is propagated across the workbook.  The changes will be propagated at one time, once  
  the Power Pivot window is closed.

Power Pivot Updates
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	 •	 Enhanced	‘Edit	Relationship’	dialog	creates	faster	and	more	accurate	data	relationships:	Power Pivot users can manually add or edit a  
  table relationship while exploring a sample of the data—up to five rows of data in a selected table.  This helps create faster and more  
  accurate relationships, without the need to go back and forth to the data view every time you wish to create or edit a table relationship

	 •	 Table	selection	using	keyboard	navigation: in the ‘Edit Relationship’ dialog, type the first letter of a table name to move the first column  
  name starting with the selected letter

	 •	 Column	selection	using	column	navigation:	in the ‘Edit Relationship’ dialog, type the first letter of a column name to move the first column  
  starting with the selected letter.  Retype the same letter moves to the next column starting with the selected letter

	 •	 Auto	column	suggestion	for	same	column	name	in	both	tables: after selecting the first table and column, on the selection of the second  
  table, if a column with the same name exists, it is auto-selected (works both ways)

	 •	 Fixes	that	improve	your	overall	modelling	user	experience:	

   1. The Power Pivot data model is no longer lost when working with hidden workbooks

   2. You can now upgrade an earlier workbook with a data model to Excel 2016 and later

   3. You can add a calculated column in Power Pivot, unless it contains a formula.

Improvements have also been made to Get & Transform (also known as Power Query):

	 •	 New	and	improved	connectors: there are now new connectors in Excel 2019.  For example, there's the new SAP HANA connector.  Excel  
  2019 has also improved many of the existing connectors so that you can import data from a variety of sources with efficiency and ease

Get & Transform (Power Query)
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	 •	 Improved	transformations:	in Excel 2019, Microsoft has significantly improved many of the data transformation features in the Power  
  Query Editor.  For example, splitting columns, inserting custom columns, adding columns from an example, merge and append operations,  
  and filtering transforms have been improved / enhanced

	 •	 General	improvements: Excel 2019 also has some general improvements across the Get & Transform area in Excel 2019.  One notable  
  improvement is the new ‘Queries & Connections’ side pane, which lets you manage queries and connections easily.  There are also many  
  improvements to the Power Query Editor as well, including “select-as-you-type” drop-down menus, date picker support for date filters and  
  conditional columns, the ability to reorder query steps via drag-and-drop and the ability to keep the layout in Excel when refreshing.  

If you have a Power BI subscription, you can now publish files that are 
stored locally to Power BI.  To get started, first save your file to your 
computer.  Then click File > Publish > Publish to Power BI.  After you 
upload, you can click the ‘Go To Power BI button’ to see the file in your 
web browser.

Finally, one thing to stress.  Excel 2019 is what is known as a “perpetual 
licence”.  Microsoft will update for security features and so forth but new 
features – described here in past newsletters – such as Dynamic Array 
functions will not be included down the road.  It’s likely you will have to 
wait until Office 2022 (assuming such a thing will exist) as Microsoft tries 
to convert everyone to the annual subscription model.

These operators are used to compare one expression with another, as long as these expressions evaluate to values.  When two values are compared 
by these operators, the result is a logical value, i.e. either TRUE or FALSE.

Publish to Power BI

Comparison Operators

Operators specify the type of calculation that you want to perform on the elements of a formula.  They are essentially the smallest building blocks of 
a calculation – even most functions are based upon these humble specifiers.  

There are four types of operator altogether: Comparison, Arithmetic, Reference and Text – think CART.  In this newsletter, we take a look at these 
four types.  Think you know everything you need to know?  Let’s see…

Operators: Horsing Around with the CART

Comparison Operator Meaning Example Comments

= (equals sign) Equal to A1=B1 Whilst all formulae begin with an 
equals sign, the actual ‘=’ here is 
seeking value equivalency.  The two 
values must be precisely equal

> (greater than sign) Greater than A1>B1 This is what mathematics calls a 
strict inequality.  The two values 
must not equal each other

< (less than sign) Less than A1<B1 Another strict inequality

>= (greater than or equals sign) Greater than or equal to A1>=B1 This is what mathematics refers to 
as an inequality (i.e. values must not 
be equal).

<= (less than or equals sign) Less than or equal to A1<=B1 Another inequality

<> (not equal to sign) Not equal to A1<>B1 Many modellers appear unaware of 
this notation and use the function 
NOT(A1=B1) instead.  This syntax is 
less efficient
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As mentioned in the table above, the equals operator is used to denote a formula in Excel.  It essentially communicates to Excel what the value of 
the cell should equal.

There are two common mistakes made by less experienced Excel users:

 1. Some modellers write ‘greater than or equal to’ as ‘=>’ rather than ‘>=’ (and similarly with ‘less than or equal to’).  Be sure Excel will advise  
  you of such an error with the ‘We found a typo’ dialog box or similar.

 2. The opposite of ‘>’ (greater than) is not ‘<’ (less than).  It is in fact ‘<=’ (less than or equal to).  Be careful any logic you employ in a model  
  allows for the two values to be identical.

As mentioned in the table above, the equals operator is used to denote a formula in Excel.  It essentially communicates to Excel what the value of 
the cell should equal.

There are two common mistakes made by less experienced Excel users:

 1. Some modellers write ‘greater than or equal to’ as ‘=>’ rather than ‘>=’ (and similarly with ‘less than or equal to’).  Be sure Excel will advise  
  you of such an error with the ‘We found a typo’ dialog box or similar.

 2. The opposite of ‘>’ (greater than) is not ‘<’ (less than).  It is in fact ‘<=’ (less than or equal to).  Be careful any logic you employ in a model  
  allows for the two values to be identical.

I once saw a brilliant typo on a website describing these type of operators as ‘arthritic operators’.  AutoCorrect is such a wonderful tool.  It’s a good 
job my spelling is sew grate or I may have create similar errors.  Whilst it is true these operators probably represent the oldest and most readily 
recognisable operators, they don’t need pensioning off just yet!

I once saw a brilliant typo on a website describing these type of operators as ‘arthritic operators’.  AutoCorrect is such a wonderful tool.  It’s a good 
job my spelling is sew grate or I may have create similar errors.  Whilst it is true these operators probably represent the oldest and most readily 
recognisable operators, they don’t need pensioning off just yet!

Arithmetic Operators

Arithmetic Operators

Arithmetic Operator Meaning Example Comments

+ (plus sign) Add A1+B1 Whilst all formulae begin with an 
equals sign, the actual ‘=’ here is 
seeking value equivalency.  The two 
values must be precisely equal

- (minus sign) Subtract 
Negate

A1-B1 
-A1

This is what mathematics calls a 
strict inequality.  The two values 
must not equal each other

* (asterisk sign) Multiply A1*B1 Another strict inequality

/ (forward slash) Divide A1/B1 This is what mathematics refers to 
as an inequality (i.e. values must not 
be equal).

% (per cent symbol) Percent 30% Another inequality

^ (caret symbol) Raises to a power, often  
referred to as exponentiation

2^4 
is 2*2*2*2

Many modellers appear unaware of 
this notation and use the function 
NOT(A1=B1) instead.  This syntax is 
less efficient

Arithmetic Operator Meaning Example Comments

+ (plus sign) Add A1+B1 Some modellers begin formulae 
with a + symbol.  This only adds an 
additional unnecessary character as 
Excel will automatically include the 
equals sign

- (minus sign) Subtract
Negate

A1-B1 
-A1

This operator serves two purposes, 
either subtracting one value from 
another, or else converting positive 
values to negative ones and vice 
versa
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* (asterisk sign) Multiply A1*B1 This is not Asterix.  That’s a cartoon 
character

/ (forward slash) Divide A1/B1 Be careful to use the forward slash 
rather than the backslash

% (per cent symbol) Percent 30% This effectively divides numbers 
(rather than references) by 100

^ (caret symbol) Raises to a power, often re-
ferred to as exponentiation

2^4 
is 2*2*2*2

Care should be taken if the number 
raised to a power is not positive

These are the operators everyone considers to be operators.  However, familiarity may breed contempt and there are potential pitfalls / tips to 
watch out for:

 1. It has been proved by greater minds than mine that using a double minus (e.g. =--A1) is the quickest way to convert a number stored as text  
  into a number.  This beats multiplying by 1 or using the VALUE function apparently.

 2. Some modellers add a zero before negating a value or cell reference.  For example, they may use the formula =0-A1 rather than =-A1 as they  
  argue it is easier to see that the value has been negated (tired eyes may easily miss the minus sign).

 3. Take care with the forward slash (‘/’) for dividing.  Some users accidentally use backslashes.  Not only may this result in an attempted  
  murder, the backslash (‘\’) is used to refer to file locations or even act as the ALT button in certain versions of Excel depending upon user  
  settings.

 4. I recommend avoiding the per cent sign (‘%’) altogether and simply divide by 100 instead.  Whilst having hard coded values in a formula  
  should be avoided, there are greater perils risked here.  The ‘%’ symbol can cause problems in certain formulae and DAX (Power Pivot)  
  expressions when shared on the internet or SharePoint as % is often used to refer to a space in a URL for example.

 5. Raising a number to a power needs to be undertaken carefully.  Not only can numbers get large very quickly (Excel seems to cope with the  
  number 10^308 if typed in but the number 1.7976931348623158 x 10^308 if calculated!), but some powers may not be evaluated as real  
  numbers.  For example, -1^0.5 attempts to evaluate the square root of -1 which is an imaginary number in mathematics (Excel does not  
  know that i or j, depending upon notation, is the square root of -1).

These operators are used to combine values and / or ranges for calculations in Excel.

Most users are unaware of the space operator.  Space may be the final frontier, but hitting the spacebar may inadvertently cause Excel to try and 
intersect ranges.  Be careful as many Microsoft Help examples are blighted by the proliferation of these pesky spaces in formulae.

Similar to the CONCATENATE function, ‘&’ is useful for connecting segments together.  Each segment must make sense on its own: an open bracket 
must be followed by a close bracket, open quotation marks require closed quotation marks later and so on.

Reference Operators

Reference Operator Meaning Example Comments

: (colon symbol) Range operator, which produces 
one reference to all of the cells 
between two references, 
including the two references 
themselves

A1:B10 Ranges do not have to be just for 
one row or column

, (comma) Union operator, combining 
multiple references into one 
reference

SUM(A1,B2,C3) For touch typists: don’t add spaces 
after a comma (see below)

‘ ’ (space) Intersect operator, which 
produces a reference to cells 
common to the two references

A1:C3 B3:B8 B3 is common to both ranges here

Text Operator Meaning Example Comments

& (ampersand symbol) Connects, or concatenates, 
two values to produce one 
continuous text value

=”The value in cell A1 is “&A1 Be careful to include spaces in text 
so that values do not ‘crash’ into 
each other

Like Highlander, there can be only one.  

Text Operator
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But it’s not as simple as just picking out an operator.  Sometimes we need to combine them – and unfortunately, they do not mix in the order we 
might think.

At school, many of us are taught a variant of BoDMAS, which stipulates the order of calculations in a mathematical expression.  The order is:

 1. Brackets: items in brackets are calculated first

 2. Powers: values are raised exponentially second

 3. Division: values are divided third

 4. Multiplication: values are multiplied fourth

 5. Addition: values are added fifth

 6. Subtraction: values are deducted from each other last.

Therefore, an expression such as

=3+8^2x5+(4/7+8)-5+9

evaluates to 335.57, when several other values may be calculated otherwise without this rule.  The problem is, this may be the way we have been 
brought up to calculate, but Excel was taught a subtly different order which sometimes leads to formulaic errors as a consequence.

Finding the correct order of operations in Excel is tricky but I reproduce the order here:

Order of Operations

Order Type of Operator Example(s)

1 Brackets or parentheses
Not strictly operators, but they force the order of operations

( [open bracket symbol] and 
) [closed bracket symbol]

2 Reference operators : (colon symbol)
‘ ’ (single space)
, (comma)

3 Negation (not subtraction), i.e. effectively multiplying by -1 - (minus sign)

4 Per cent % (per cent symbol)

5 Exponentiation (raising to a power) ^ (caret symbol)

6 Multiplication and division (reading from left to right, not that this 
matters as these operations are mathematically associative)

* (asterisk sign) and
/ (forward slash)

7 Addition and subtraction (again, associative) + (plus sign) and
- (minus sign)

8 Text operator & (ampersand symbol)

9 Comparison operators = (equals sign)
<> (not equal to sign) etc.

Do you see the slight differences?  Negating in general (essentially 
multiplying by -1) and dividing by 100 (per cent) will both be computed 
ahead of exponentiation.  This may not be what you expect.  

I strongly recommend that you take a look at some of your more complex 
formulae.  Stepping out calculations not only makes logic easier to follow 
but also ensures that computations are executed in the desired order.  If 
all else fails, inserting brackets, like Star Wars, will “use the Force”.

It’s not all about the Power Tools, you know.  We thought we’d run a new elementary series going through the rudiments of Visual Basic for Applications 
(VBA) as a springboard for newer users.  This month, we actually at the basic principles of VBA.

Macros are organised and stored in the following way in VBA.  The following common items are the principal components we need to know.

Visual Basics
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	 •	 A	statement	is a single command or action in a macro – that is, it's a line of code.  For example, Range("B3").Select is a statement.   
  If we think of VBA as a language, think of a statement as a sentence

 • A	procedure	is, essentially, another way of referring to a macro, although there are other types of procedures as well, such as functions.   
  A function is a procedure that returns a result

 • A module is a collection of code.  Think of a module as a code document.  A module can contain several procedures.  Like documents,  
  modules can be saved as files, copied and shared

A project	is the collection of all modules and related VBA objects in our document, template or add-in.  A project might have one or several 
modules, as well as other elements such as UserForms (dialog boxes).

More next month.

Each month we’ll reproduce one of our articles on Power Query (Excel 2010 and 2013) / Get & Transform (Excel 2016) from www.sumproduct.com/
blog.  If you wish to read more in the meantime, simply check out our Blog section each Wednesday.  This month, we look at simple manipulation of 
table data. 

Whilst creating data to use for training and blogs, the team has spent significant time manipulating data in a Microsoft Access database.  It is however 
possible to do much of this transforming in Power Query and this month we take a look at a simple example.  We have a table ‘Employees’ which sits 
in our database, and we will extract it to Power Query in order to make some changes:

We have a list of employees, and they are each allocated an area and a sales territory.  However, thinking ahead here, and thanks to 52% of voting 
UK citizens, the UK will soon no longer be in the European Union.  We need to change the data to show UK instead of EU in the sales territory.  Let’s 
begin by editing the query.

Power Query Pointers
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With the SALES_TERRITORY_KEY column highlighted, go to the ‘Transform’ Menu and choose to ‘Replace Values’:

We will enter values such that ‘EU’ may be replaced with the new value ‘UK’.  Let’s use the ‘Advanced Options’ to match the entire cell to make sure 
we don’t inadvertently pick up some other region with an ‘EU’ in it.  It might be best to have some conditional logic in this box in future updates of 
Power Query but for now, it’s an absolute replacement of all values.  Press ‘OK’ and…
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Instantaneously, the UK is out of the EU (it’s a shame it won’t be this simple outside of Power Query!).

Next, close and load the query:

We may put our updated employee data into the Access database if we so choose.  We can create a new empty copy of the ‘Employees’ table called 
‘Employees Updated by PQ’ and paste our data in.

The data is now updated and ready to use. 

More next month!

Perhaps a few less updates than in recent months, but that’s to be expected and there’s still enough to keep you on your toes!  Here’s the full run 
down of the November updates:

Reporting

 • Expand and collapse matrix row headers
 • Copy and paste between Power BI Desktop files
 • Updated filtering experience (Preview)
 • Report accessibility improvements

Analytics

 • Colour saturation on visuals upgraded to use conditional formatting
 • Follow-up questions in the Q&A explorer

November Updates for Power BI Desktop
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Modelling

	 •	New	modelling	view	(Preview)
	 •	Composite	models	now	Generally	Available
	 •	Modeling	accessibility	improvements
	 •	New	DAX	functions

Custom Visuals

	 •	 Calendar	by	MAQ	Software
	 •	Ratings	by	MAQ	Software
	 •	Hourglass	Chart	by	MAQ	Software
	 •	 Forecast	Using	Multiple	Models	by	MAQ	Software
	 •	 Pie	Charts	Tree

Data Connectivity

	 •	Azure	DevOps	Server	connector
	 •	 PDF	Connector	support	for	Start	Page	and	End	Page	parameters
	 •	 Improved	Azure	Consumption	Insights	connector.

Let’s	go	through	each	new	feature	in	turn.

Expand and collapse matrix row headers

This update provides you with the ability to expand and collapse individual row headers.  There are two ways you can expand row headers.  

The first method is through the right-click menu.  You’ll see options to expand the specific row header you clicked on, the entire level or everything 
down to the very last level of the hierarchy.   You have similar options for collapsing row headers as well.

The second method is to add + / - buttons to the row headers through the ‘Formatting’ pane under the ‘Row Headers’ card.  By default, the icons will 
match the formatting of the row header, but you may customise the icons’ colours and sizes separately should you wish.

Once the icons are turned on, they work similarly to the icons from PivotTables in Excel. 
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Once the icons are turned on, they work similarly to the icons from PivotTables in Excel. 

The expansion state of the matrix will save with your report.  It can be pinned to dashboards as well, but consumers will need to open up the report 
to change the state.  It should be noted though that conditional formatting will only apply to the inner most visible level of the hierarchy.

These latest updates also allow you to copy visuals between .pbix files.  This means you may now copy a visual either through the visual’s context 
menu or through the standard CTRL + C keyboard shortcut and paste it into another report through CTRL + V.

Copy and paste between Power BI Desktop files
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This is very useful if you build and update multiple reports frequently.  
When copying between files, formatting that has been explicitly set in 
the formatting pane will carry forward, and anything that is relying on 
a theme or the default settings will update to match the theme of the 
destination report. 

If the fields in your model are different, you’ll see an error on the visual 
and a warning on the fields that don’t exist, similar to what you would 
see if you were to delete a field in the model that a visual is using.  All 
you’ll need to do is replace the broken fields with the ones you want to 
use from the new model.  If you are using a custom visual, you’ll also 
need to import it to the destination file as well.

If only you could get a ‘Fix This’ button for life in general, eh?

For existing reports, you’ll additionally need to check the option under ‘Report settings’ in the ‘Options’ dialog, viz.

The ‘Filter’ pane is a very important part of any report, and Microsoft 
claims they have been listening to the feedback provided by a multitude 
of end users.  One such concern was that consumers do not understand 
which filters are affecting a visual.  Not only does the filter pane showing 

up as collapsed at the corner of the report making it difficult to notice, it 
also didn’t have enough configuration and customisation options to meet 
all users’ needs when building reports.  Based on all of this feedback, 
Microsoft has created a Preview of a fully revamped filtering experience. 

This new filter pane has many new features such as:

 • Hide individual filters or the entire filter pane from report consumers
 • Lock filters as read-only for report consumers
 • Formatting options for the filter pane to make it feel like part of the report
 • Flexibility of defining default expand / collapsed filter pane at report load time for consumers
 • Read only view of filters affecting a visual directly on visuals.

To start using this new ‘Filter’ pane, you will first need to enable it through the ‘Preview features’ section of the ‘Options’ dialog.  After this, it will be 
enabled for all new reports:

Updated filtering experience (Preview)
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Once the new ‘Filter’ pane is enabled, you’ll see it attached to the report 
page.  It will be formatted by default based on your current report 
settings.  This new ‘Filter’ pane is what your report consumers will see 
when you publish your report, and the older filter pane now acts as a 
filter editing pane.  This means you can update existing filters through 
the new pane, but you’ll use the older filter pane to configure which 
filters to include.

In case you are wondering why there are two ‘Filter’ panes, Microsoft 
has stated that the new ‘Filter’ pane provides you with a taste of what 

end users will see without publishing the report (same as any other 
visual in your report).  However, in a few months, Microsoft plans to 
remove the old ‘Filter’ pane so that the new pane will be used to add 
new filters as well. 

To show and hide the new filter pane, you can use the eye icon next to 
‘FILTERS’ title of the ‘Filter’ editing pane.  This saves with the report, 
so you’ll be able to completely hide the ‘Filter’ pane from your report 
consumers if you want. 

You can also use the ‘Filter’ editing pane to lock or hide individual filter cards.  As you toggle these settings in the editor, you’ll see the changes 
reflected in the new ‘Filter’ pane:
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Through the ‘Formatting’ pane you can format both the new ‘Filter’ pane, and the individual filter cards.  For the ‘Filter’ pane, you can format the 
background colour and transparency, the font and icon colours, and the colour and visibility of the left border of the pane. 

You can format the ‘Filter’ card’s background colour and transparency and border colour and visibility.  Users are able to format these properties for 
both the state when the filter is cleared (Available) and the state when the filter is set to something (Applied).
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Another benefit of this new experience is that you can now see a 
read-only view of filters that are affecting each visual.  You can hover 
over a filter icon in the visual’s header to see filters, slicers and cross-
highlighting state that is affecting what data is showing in the visual.  

This new icon is on by default (provided your Preview switch is checked 
as called out above), but of course you can turn it off for your report 
consumers through the visual header card in the ‘Formatting’ pane. 

There are plenty of accessibility improvements this month in the reporting space. 

It should be noted that the selection pane is now fully accessible.  This includes keyboard navigation, screen reader support and high contrast support.  
When using the selection pane with a keyboard, once you open the selection pane from the Ribbon, your focus will move directly to the pane.  From 
there you can tab through all the buttons on pane.  When your focus is on the list, you can press F6 to "activate" the list and use up / down arrows to 
cycle through the list of visuals.  While your focus is on an individual object in the ‘Selection’ pane list, you can use the following hotkeys:

 • Select / deselect an object: ENTER or SPACEBAR
 • Multi-select: CTRL + SPACE
 • Move an object up in the layering: CTRL + SHIFT + F
 • Move an object down in the layering: CTRL + SHIFT + B
 • Hide / show (toggle) an object: CTRL + SHIFT + S.

Press TAB to exit the activated list and return to the top of the pane.

The following experiences also fully support keyboard navigation, screen readers, and high contrast settings: 

 • ‘Q&A explorer’ dialog
 • ‘Getting started’ dialog
 • ‘File Menu’ and ‘About’ dialogs
 • Warning bar
 • ‘File Restore’ dialog
 • ‘Frowns’ dialog.

Report accessibility improvements
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Furthermore, you may quickly navigate to different areas of Power BI Desktop through CTRL + F6.  Instead of just jumping between visuals on a page 
and the page tab switcher, you can also quickly jump to whatever panes are currently visible, the view switcher on the left and the account options 
on the top right.  You can still reach the Ribbon through pressing the ALT key. 

Once there, you can use any of the three conditional formatting options and select ‘OK’ to apply the formatting.

	 •	 All	variants	of	column	and	bar	charts
	 •	 Funnel	chart
	 •	 Bubble	and	filled	maps
	 •	 Shape	map	(Preview)
	 •	 Treemap
	 •	 Scatter	chart.

With	this	upgrade,	you’ll	notice	the	colour	saturation	bucket	is	no	longer	in	the	field	well.		Instead	to	format,	you’ll	go	to	the	‘Data	colors’	card	in	
the	‘Formatting’	pane.		Here	you	can	format	with	the	colour	pickers	as	normal	or	select	the	‘Advanced’	controls	option	to	launch	the	conditional	
formatting	dialog.

For quite a while now, there have been two different ways to dynamically 
colour a visual’s data points depending on the visual type.  Charts had a 
colour saturation option in the field well that gave you basic controls, and 
the table and matrix visuals had conditional formatting.  Recent updates 
have added functionality to the conditional formatting experience for 
table and matrix over the last year, but the colour saturation feature for 
cartesian charts hasn’t received much attention. 

That has finally changed in this update.  Microsoft has now upgraded all 
of the visuals that previously used colour saturation to have the same 
conditional formatting experience as table and matrix currently has.  
This means you’ll have access to all three types of formatting currently 
available: Color by color scales, Color by rules, and Color by field.  As 
mentioned, this change impacts all visuals which previously had color 
saturation which includes:

Colour saturation on visuals upgraded to use conditional formatting
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And that’s it! The conditional formatting colours will apply on top of whatever formatting you already have through theming and manually picking 
through the colour pickers.

You can now ask follow-up questions in the ‘Q&A explorer’ dialog, which means that the answers to your questions can take into account the 
previous question’s context.   For example, you can start by asking for the products sold by Fabrikam:

Then you can click the ‘Ask a follow-up’ button and ask the follow-up question for the sales for each of those products.

Follow-up questions in the Q&A explorer
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You can continue to ask follow-up questions and can even change filter context, e.g. by asking to show Contoso products instead:

Here are some types of follow-up questions you can ask and the phrasing to use:

 • Add another field: “Include brand name”
 • Extend filter: “For Contoso as well”
 • Add a filter: “what about 2015?”
 • Replace filters: “Show Contoso instead” or “What about for Contoso?”.

We think this is going to be very popular…
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Another major improvement this time out is the Preview of the new ‘Modelling’ view.  Microsoft has been working on this new view for a while now.  
This new version has many new features including:

 • Faster performance on large models with many tables
 • Customise and save diagram view layouts
 • Multiple diagram layouts
 • Modelling options through the ‘Field properties’ pane and field list
 • Display folder creation
 • Apply common settings to multiple fields at once.

The recent composite models feature is now Generally Available.  It 
does differ slightly from its Preview predecessor.  Microsoft now allows 
relationships that are between different sources to have a cardinality 
of ‘Many to 1’ to reflect the actual cardinality of the data.  While the 

relationships still have the same “weak” behaviour as relationships that 
have a cardinality of ‘Many-to-Many’, allowing the true cardinality to be 
defined, permits additional optimisations and clearer models. 

Finally, there’s three new DAX updates.  In support of the new expand / collapse feature for the matrix visual, there’s now an additional optional 
DrilldownFilter argument for the RollupAddIsSubtotal function and a new NonVisual function. 

Additionally, Microsoft has also added the IsInScope function, which is a better way to detect hierarchy level in a measure expression.  Some popular 
tasks you might need this for include:

 • Calculating child percentage of parent subtotal
 • Calculating ranks of children under different parents.

The ‘Modelling’ experience has accessibility improvements with this update.  Keyboard navigation, screen reader support and high contrast setting 
support have been added to the following:

 • ‘Manage relationships’ dialog
 • ‘Edit relationships’ dialog
 • ‘Manage roles’ dialog for Row Level Security (RLS).

Once you turn on the Preview in the ‘Options’ dialog, you’ll see two relationships views.  You’ll be able to recognise the new {review one through a 
little star on the bottom right corner of the icon:

New modelling view (Preview)

Composite models now Generally Available

New DAX functions

Modeling accessibility improvements
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The Calendar by MAQ Software custom visual is a method to track events within your Power BI report.  Some key features include:

 • Grouping events based on category
 • Month, week, day and list views
 • Navigate to event details with a single click
 • Set workdays and hours.

The Ratings by MAQ Software custom visual allows you to add ratings or scores to your reports.  You can show either the average ratings or break it 
down over a specific category.  You’re able to choose between four different shapes and between a solid and gradient fill.

The Hourglass Chart by MAQ Software custom visual lets 
you compare category values between two scenarios, 
which can be useful when showing conversion rates.

With this visual you can:

 • Cross-highlight individual categories
 • Display it either horizontally or vertically
 • Animate individual categories on hover
 • Add and remove the conversion box.

Calendar by MAQ Software

Ratings by MAQ Software

Hourglass Chart by MAQ Software
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The Forecast Using Multiple Models by MAQ Software R custom visual 
lets you forecast future values based on historical data using four 
different forecasting models.  The models include Linear Regression, 

ARIMA, Exponential Smoothing and Neural Network.  You can manually 
adjust the parameters of the learning model, show the confidence 
intervals and decide upon the split point.

The Pie Charts Tree custom visual by Aritz Fancoy lets you display a tree 
visual with pie charts as the nodes.  To create a plain tree structure all 
you need to do is add multiple fields to the ‘Categories’ bucket in the 

‘Fields’ list.  From there you can add data labels with the ‘Values’ bucket, 
percent of target pie charts with the ‘Target’ bucket, and progress 
percentage with the Progress field.

This update also sees the release of a new connector for Azure DevOps Server, allowing you to import and transform data from Azure DevOps Server in 
order to build Power BI reports.  The new Azure DevOps Server Connector can be found under the Online Services category within the Get Data dialog.

Forecast Using Multiple Models by MAQ Software

Pie Charts Tree

Azure DevOps Server connector
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The PDF Files connector has been enhanced in this release to allow you to specify Start Page and End Page optional parameters, which restricts Power 
Query to only explore a given range of pages for discovering tables.

These parameters can be specified in the M formula generated after connecting to a PDF file: Pdf.Tables(File.Contents("c:\sample.pdf"), [StartPage=10, 
EndPage=11])

Finally, Microsoft has also enhanced the Azure Consumption Insights connector to add ‘Budget’ and ‘Reserved Instances’ data.

More next month we’re sure!

PDF Connector support for Start Page and End Page parameters

Improved Azure Consumption Insights connector

If you have read the above, you can’t help but notice the direction Power BI is going in.  We often get asked the difference between Qlik, Tableau 
et al and whilst we try to remain [reasonably] neutral, you would have to be blind not to recognise Power BI makes it possible for everyone to have 
access to better data and dashboards. 

But that’s just one aspect.

With the massive volumes of data generated today about every aspect of a business, finding insights from the data can be challenging.  This is where 
Artificial Intelligence (AI) can help and doesn’t replace the analyst but supports them.  AI can aid in data exploration, comb through the data to 
automatically find patterns, help users understand what the data means and predict future outcomes to help business drive results.

Power BI has been applying AI through capabilities such as natural language, which enables users to get answers by asking questions in plain English, 
or Quick Insights, which automatically finds patterns in data.  There’s more though: here’s some features presently reviewed in more detail that are 
in Preview:

	 •	 users	can	now	get	capabilities	such	as	image	recognition	and	text	analytics	directly	in	Power	BI
	 •	 Key	driver	analysis	helps	users	understand	what	influences	key	business	metrics
	 •	 users	can	create	machine	learning	models	directly	in	Power	BI	using	automated	machine	learning
	 •	 users	now	have	seamless	integration	of	Azure	Machine	Learning	within	Power	BI.	

All	these	new	AI	capabilities—pioneered	in	Azure	and	now	available	in	Power	BI—require	no	code.		That’s	great	for	the	average	user.		This	enables	all	
Power	BI	users	to	discover	hidden,	actionable	insights	in	their	data	and	drive	better	business	outcomes	with	easy-to-use	AI	and	not	be	a	“geek	freak”.

New Artificial Intelligence (AI) Capabilities for Power BI
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Azure Cognitive Services are sophisticated pre-trained machine learning 
models that can extract insights from data.  Microsoft is bringing Azure 
Cognitive Service capabilities into Power BI to provide powerful ways to 
extract information from a variety sources like documents, images and 
social media feeds.  These algorithms can identify named entities such 
as organizations, people and locations.  They can recognise objects in 
images, detect language, identify key phrases and determine positive or 
negative sentiment.

For example, imagine you’re a business analyst for a hotel chain and want 
to evaluate what guests are saying in their online reviews.  With Azure 
Cognitive Services in Power BI, you could analyse thousands of online 
reviews, understand what your guests are happy or unhappy about, and 
pinpoint areas of improvement.  In the example below, the user can 
understand that a specific hotel has issues with air conditioning, causing 
customer dissatisfaction and negative reviews.  Azure Cognitive Services 
capabilities in Power BI can surface this insight automatically, so the hotel 
can take action.    

Every organisation has metrics or key performance indicators (KPIs) that 
measure business success.  How do businesses determine what impacts 
those KPIs?  What causes these KPIs to go up, down or stay the same?  
The most obvious business drivers are typically easy to spot, but it doesn’t 
take long before things get complex.  What drives business outcomes is 
often subtle and depends on any combination of circumstances.  

Key driver analysis helps you understand what drives an outcome.   
It reasons over your data, ranks those things that matter and surfaces 
those key drivers.  For example, consider a student’s plans to attend 
college as a KPI.  There are different factors that impact whether kids plan 
to enrol in college.  Key driver analysis automatically surfaces those things 
that matter the most.  Below, you see that parental encouragement has 
significant positive impact on a student’s plans.

In Power BI, business analysts will now be able to build their own machine 
learning models without writing a single line of code.  Microsoft is using 
the automated machine learning feature in Azure Machine Learning, 
but instead of targeting developers or data scientists, they have made 
it broadly accessible for common use cases.  This means that when an 
analyst builds a machine learning model in Power BI, it does all the heavy 
lifting by selecting the best algorithm and features with just a few clicks. 

As an example, a business analyst could leverage the automated machine 
learning technology to quickly and easily build a model to predict how 
likely an open sales opportunity is to be won.  This could help a sales 
manager prioritise which high value opportunities to focus on and how 
likely they are to meet their target.

Azure Cognitive Services Capabilities in Power BI 

New Key Driver Analysis Feature in Power BI

Build Your Own Machine Learning Models in Power BI
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Advanced Machine Learning requires specialised data science tools.  
This is a platform where data scientists develop machine learning 
models to take on complex business challenges.  These models built by 
data scientists can now be easily shared with business analysts.  Power 
BI works behind the scenes to discover the models to which each user 
has access and automatically creates a point and click user interface to 
invoke them.  This makes collaboration among business analysts and data 
scientists easier and faster than ever before.  

Power BI is building on years of work in Microsoft Research and Azure, 
and bringing these capabilities to any business user, regardless of their 
coding skill.  Complex tasks that typically require technical know-how — 
key phrase extraction, sentiment analysis, understanding drivers, creating 
machine learning models—will now be possible with just a few clicks and 
without code.  This will empower everyone in an organisation to harness 
the power of AI to make better decisions.  Roll on the Preview.

Integrate Azure Machine Learning Models with Power BI 

When an Excel workbook is connected to a Microsoft SQL Server 
2005 Analysis Services or later data source, this function returns a key 
performance indicator (KPI) property and displays the KPI name in the 

cell.  A KPI is a quantifiable measurement, such as monthly gross profit or 
quarterly employee turnover, that is used to monitor an organisation's 
performance.

The CUBEKPIMEMBER function employs the following syntax to operate:

CUBEKPIMEMBER(connection, kpi_name, kpi_property, [caption])

The CUBEKPIMEMBER function has the following arguments:

 • connection: this is required and represents a text string of the name of the connection to the cube
 • kpi_name: this is also required.  This is a text string of the name of the KPI in the cube
 • kpi_property: again, this is required.  This is the KPI component returned and can be one of the following:

The A to Z of Excel Functions: CUBEKPIMEMBER
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	 •	 caption:	this is optional.  This represents an alternative text string that is displayed in the cell instead of	kpi_name	and kpi_property.

It should be further noted that: 

 • the CUBEKPIMEMBER function is supported only when the workbook is connected to a Microsoft SQL Server 2005 Analysis Services or later  
  data source
 • when the CUBEKPIMEMBER function evaluates, it temporarily displays a "#GETTING_DATA…" message in the cell before all of the data is  
  retrieved
 • to use the KPI in a calculation, specify the CUBEKPIMEMBER function as a member_expression argument in the CUBEVALUE function
 • if the connection name is not a valid workbook connection that is stored in the workbook, CUBEKPIMEMBER returns an #NAME? error value.   
  If the Online Analytical Processing (OLAP) server is not running, not available or returns an error message, CUBEKPIMEMBER returns a  
  #NAME? error value
 • CUBEKPIMEMBER returns an #N/A error value when kpi_name or kpi_property is invalid
 • if you specify KPIValue for kpi_property, only kpi_name is displayed in the cell
 • CUBEKPIMEMBER may return an #N/A error value if you reference a session-based object, such as a calculated member or named set, in a  
  PivotTable when sharing a connection, and that PivotTable is deleted or you convert the PivotTable to formulae (on the ‘Options’ tab in the  
  Ribbon, in the ‘Tools’ group, click ‘OLAP Tools’, and then click ‘Convert to Formulas’).

Please see our examples below: 

=CUBEKPIMEMBER("Sales","MySalesKPI",1)

=CUBEKPIMEMBER("Sales","MySalesKPI", KPIGoal,"Sales KPI Goal").

Again, when a workbook is connected to a Microsoft SQL Server 2005 Analysis Services or later data source, this function returns a member or tuple 
from the cube.  This is used to validate that the member or tuple exists in the cube.

The CUBEMEMBER function employs the following syntax to operate:

CUBEMEMBER(connection, member_expression, [caption])

The CUBEMEMBER function has the following arguments:

 • connection: this is required and represents a text string of the name of the connection to the cube
 • member_expression: this is also required.  This is a text string of a multi-dimensional expression (MDX) that evaluates to a unique member in  
  the cube.  Alternatively, member_expression can be a tuple, specified as a cell range or an array constant
 • caption: this is optional.  This represents a text string displayed in the cell instead of the caption, if one is defined, from the cube.  When a  
  tuple is returned, the caption used is the one for the last member in the tuple.

It should be further noted that: 

 • the CUBEKPIMEMBER function is supported only when the workbook is connected to a Microsoft SQL Server 2005 Analysis Services or later  
  data source
 • when the CUBEMEMBER function evaluates, it temporarily displays a "#GETTING_DATA…" message in the cell before all of the data is  
  retrieved
 • when you use CUBEMEMBER as an argument to another CUBE function, the MDX expression that identifies the member or tuple is used by  
  that CUBE function, not the displayed value in the cell of the CUBEMEMBER function
 • if the connection name is not a valid workbook connection stored in the workbook, CUBEMEMBER returns a #NAME? error value.  If the  
  Online Analytical Processing (OLAP) server is not running, not available or returns an error message, CUBEMEMBER returns a #NAME? error  
  value
 • if at least one element within the tuple is invalid, CUBEMEMBER returns an #VALUE! error value
 • if member_expression is longer than 255 characters, which is the limit for an argument to a function, CUBEMEMBER returns a #VALUE! error  
  value.  To use text strings longer than 255 characters, enter the text string in a cell (for which the limit is 32,767 characters), and then use a  
  cell reference as the argument instead

The A to Z of Excel Functions: CUBEMEMBER
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	 •	CUBEMEMBER	returns	an	#N/A	error	value	when:
	 	 	 o	 the	member_expression	syntax	is	incorrect
	 	 	 o	 the	member	specified	by	the	MDX	text	string	doesn't	exist	in	the	cube
	 	 	 o	 the	tuple	is	invalid	because	there	is	no	intersection	for	the	specified	values	(this	can	occur	with	multiple	elements	from	the	same		
	 	 	 	 hierarchy)
	 	 	 o	 the	set	contains	at	least	one	member	with	a	different	dimension	than	the	other	members
	 •	CUBEMEMBER	may	return	an	#N/A	error	value	if	you	reference	a	session-based	object,	such	as	a	calculated	member	or	named	set,	in	a		
	 	 PivotTable	when	sharing	a	connection,	and	that	PivotTable	is	deleted	or	you	convert	the	PivotTable	to	formulae	(on	the	‘Options’	tab	in	the		
	 	 Ribbon,	in	the	‘Tools’	group,	click	‘OLAP	Tools’,	and	then	click	‘Convert	to	Formulas’).

Please	see	our	examples	below:	

=CUBEMEMBER("Sales","[Time].[Fiscal].[2020]")

=CUBEMEMBER($A$1,D$12)

=CUBEMEMBER("Sales",(B4, C6, D5),"SalesFor2020")

=CUBEMEMBER("xlextdat8 FoodMart 2020 Sales","([Product].[Food],[Time].[2019])")

=CUBEMEMBER($A$1,C$12:D$12).

Continuing the theme of connecting to a Microsoft SQL Server 2005 Analysis Services or later data source, the CUBEMEMBERPROPERTY function, 
one of the Cube functions in Excel, returns the value of a member property from a cube.  You may use it to validate that a member name exists within 
the cube, and to return the specified property for this member. 

The CUBEMEMBERPROPERTY function employs the following syntax to operate:

CUBEMEMBERPROPERTY(connection, member_expression, property)

The CUBEMEMBERPROPERTY function has the following arguments:

 • connection: this is required and represents a text string of the name of the connection to the cube
 • member_expression: this is also required.  This is a text string of a multi-dimensional expression (MDX) of a member within the cube
 • property: again, this is required and represents a text string of the name of the property returned or a reference to a cell that contains the  
  name of the property.

It should be further noted that: 

 • the CUBEMEMBERPROPERTY function is supported only when the workbook is connected to a Microsoft SQL Server 2005 Analysis Services or  
  later data source
 • when the CUBEMEMBERPROPERTY function evaluates, it temporarily displays a "#GETTING_DATA…" message in the cell before all of the  
  data is retrieved
 • if the connection name is not a valid workbook connection stored in the workbook, CUBEMEMBERPROPERTY returns an #NAME? error value.   
  If the Online Analytical Processing (OLAP) server is not running, not available or returns an error message, CUBEMEMBERPROPERTY returns  
  an #NAME? error value
 • if the member_expression syntax is incorrect or if the member specified by member_expression doesn't exist in the cube,    
  CUBEMEMBERPROPERTY returns an #N/A error value 
 • CUBEMEMBERPROPERTY may return an #N/A error value if you reference a session-based object, such as a calculated member or named set,  
  in a PivotTable when sharing a connection, and that PivotTable is deleted or you convert the PivotTable to formulae (on the ‘Options’ tab in  
  the Ribbon, in the ‘Tools’ group, click ‘OLAP Tools’, and then click ‘Convert to Formulas’)
 • CUBEMEMBERPROPERTY will not work against Excel Data Models that are edited in Power Pivot, since they are not multi-dimensional cubes.

Please see more examples below: 

=CUBEMEMBERPROPERTY("Sales","[Time].[Fiscal].[2020]",$A$3)

=CUBEMEMBERPROPERTY("Sales","[Store].[MyFavoriteStore]","[Store].[Store Name].[Store Sqft]").

Using Microsoft SQL Server 2005 Analysis Services or later as a data source, this function returns the nth, or ranked, member in a set.  Use this to 
return one or more elements in a set, such as the top sales performer or the top 10 students.

The CUBERANKEDMEMBER function employs the following syntax to operate:

CUBERANKEDMEMBER(connection, set_expression, rank, [caption])

The CUBERANKEDMEMBER function has the following arguments:

 • connection: this is required and represents a text string of the name of the connection to the cube
 • set_expression: this is also required.  This is a text string of a set expression, such as "{[Item1].children}"

The A to Z of Excel Functions: CUBEMEMBERPROPERTY
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	 •	 set_expression	can	also	be	the	CUBESET	function	or	a	reference	to	a	cell	that	contains	the	CUBESET	function
	 •	 rank:	again,	this	is	required.		This	is	an	integer	value	specifying	the	top	value	to	return.		If	rank	is	a	value	of	1,	it	returns	the	top	value,	if	rank  
	 	 is	a	value	of	2,	it	returns	the	second	most	top	value,	and	so	on.		To	return	the	top	5	values,	use	CUBERANKEDMEMBER	five	times,	specifying	a		
	 	 different	rank,	1	through	5,	each	time
	 •	 caption:	this	argument	is	optional.		This	is	a	text	string	displayed	in	the	cell	instead	of	the	caption,	if	one	is	defined,	from	the	cube.

It	should	be	further	noted	that:	

	 •	 the	CUBERANKEDMEMBER	function	is	supported	only	when	the	workbook	is	connected	to	a	Microsoft	SQL	Server	2005	Analysis	Services	or		
	 	 later	data	source
	 •	when	the	CUBERANKEDMEMBER function	evaluates,	it	temporarily	displays	a	"#GETTING_DATA…"	message	in	the	cell	before	all	of	the	data	is		
	 	 retrieved
	 •	 if	the	connection	name	is	not	a	valid	workbook	connection	stored	in	the	workbook,	CUBERANKEDMEMBER	returns	an	#NAME?	error	value.			
	 	 If	the	Online	Analytical	Processing	(OLAP)	server	is	not	running,	not	available	or	returns	an	error	message,	CUBERANKEDMEMBER	returns	an		
	 	 #NAME?	error	value
	 •	CUBERANKEDMEMBER	returns	an	#N/A	error	value	when	the	syntax	of	set_expression	is	incorrect	or	when	the	set	contains	at	least	one		
	 	 member	with	a	different	dimension	than	the	other	members
	 •	 to	return	the	bottom	n	values	instead,	use	the	sort_order	and	sort_by	arguments	of	the	CUBESET	function	to	reverse	the	order	of	the		
	 	 set	so	that	the	top	values	in	the	sorted	set	are	the	bottom	values.		For	example,	CUBERANKEDMEMBER	("Sales",$D$4,1)	returns	the	last		
	 	 member,	CUBERANKEDMEMBER	("Sales",$D$4,2)	returns	the	next	to	last	member,	and	so	on.

Please	see	our	examples	below:	

=CUBERANKEDMEMBER("Sales",$D$4,1,"Top Month")

=CUBERANKEDMEMBER("Sales",CUBESET("Sales","Summer","[2020].[June]","[2020].[July]","[2020].[August]"),3,"Top Month").

Just for a change, if you connect to a Microsoft SQL Server 2005 Analysis Services or later data source, this function defines a calculated set of 
members or tuples by sending a set expression to the cube on the server, which creates the set, and then returns that set to Microsoft Excel.

The CUBESET function employs the following syntax to operate:

CUBESET(connection, set_expression, [caption], [sort_order], [sort_by])

The CUBESET function has the following arguments:

 • connection: this is required and represents a text string of the name of the connection to the cube
 • set_expression: this is also required.  This is a text string of a set expression that results in a set of members or tuples
 • set_expression can also be a cell reference to an Excel range that contains one or more members, tuples or sets included in the set
 • caption: this is optional.  This is a text string that is displayed in the cell instead of the caption, if one is defined, from the cube
 • sort_order: this is also optional.  This is the type of sort, if any, to perform and can be one of the following:

	 •	 sort_by:	this	is	optional	and	represents	a	text	string	of	the	value	by	which	to	sort.		For	example,	to	get	the	city	with	the	highest	sales,		
	 	 set_expression	would	be	a	set	of	cities	and	sort_by	would	be	the	sales	measure.		Alternatively,	to	get	the	city	with	the	highest	population,		
	 	 set_expression	would	be	a	set	of	cities,	and	sort_by	would	be	the	population	measure.		If	sort_order	requires	sort_by	and	sort_by	is	omitted,		
	 	 CUBESET	returns	the	#VALUE!	error	message.

It	should	be	further	noted	that:	

	 •	 the	CUBESET	function	is	supported	only	when	the	workbook	is	connected	to	a	Microsoft	SQL	Server	2005	Analysis	Services	or	later	data		
	 	 source
	 •	when	the	CUBESET	function	evaluates,	it	temporarily	displays	a	"#GETTING_DATA…"	message	in	the	cell	before	all	of	the	data	is	retrieved
	 •	 if	the	connection	name	is	not	a	valid	workbook	connection	stored	in	the	workbook,	CUBESET	returns	an	#NAME?	error	value.		If	the	Online		
	 	 Analytical	Processing	(OLAP)	server	is	not	running,	not	available	or	returns	an	error	message,	CUBESET	returns	an	#NAME?	error	value
	 •	 if	the	set_expression	syntax	is	incorrect	or	the	set	contains	at	least	one	member	with	a	different	dimension	than	the	other	members,		
	 	 CUBESET returns	an	#N/A error	value

The A to Z of Excel Functions: CUBESET
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	 •	 If	set_expression is	longer	than	255	characters,	which	is	the	limit	for	an	argument	to	a	function,	CUBESET	returns	an	#VALUE!	error	value.			
	 	 To	use	text	strings	longer	than	255	characters,	enter	the	text	string	in	a	cell	(for	which	the	limit	is	32,767	characters),	and	then	use	a	cell		
	 	 reference	as	the	argument

	 •	CUBESET	may	return	an	#N/A error	value	if	you	reference	a	session-based	object,	such	as	a	calculated	member	or	named	set,	in	a	PivotTable		
	 	 when	sharing	a	connection,	and	that	PivotTable	is	deleted	or	you	convert	the	PivotTable	to	formulae	(on	the	‘Options’	tab	in	the	Ribbon,	in		
	 	 the	‘Tools’	group,	click	‘OLAP	Tools’,	and	then	click	‘Convert	to	Formulas’).

Please	see	examples	below:	

=CUBESET("Finance","Order([Product].[Product].[Product Category].Members,[Measures].[Unit Sales],ASC)","Products")

=CUBESET("Sales","[Product].[All Products].Children","Products",1,"[Measures].[Sales Amount]").

When the workbook is connected to a Microsoft SQL Server 2005 Analysis Services or later data source, this function returns the number of items 
in a set.

The CUBESETCOUNT function employs the following syntax to operate:

CUBESETCOUNT(set)

The CUBESETCOUNT function has the following arguments:

 • set: this is required and represents a text string of a Microsoft Excel expression that evaluates to a set defined by the CUBESET function
 • set can also be the CUBESET function, or a reference to a cell that contains the CUBESET function.

It should be further noted that: 
 • the CUBESETCOUNT function is supported only when the workbook is connected to a Microsoft SQL Server 2005 Analysis Services or later  
  data source
 • when the CUBESETCOUNT function evaluates, it temporarily displays a "#GETTING_DATA…" message in the cell before all of the data is  
  retrieved.

Please see the examples below: 

=CUBESETCOUNT(A3)

=CUBESETCOUNT(CUBESET("Sales","[Product].[All Products].Children","Products",1,"[Measures].[Sales Amount]")).

Finally, let’s shake it up for our last function this month and, er, link an Excel workbook to a Microsoft SQL Server 2005 Analysis Services or later data 
source.  Then, this function returns an aggregated value from the cube.

The CUBEVALUE function employs the following syntax to operate:

CUBEVALUE(connection, [member_expression1], [member_expression2], …)

The CUBEVALUE function has the following arguments:

 • connection: this is required and represents a text string of the name of the connection to the cube
 • member_expression: these arguments are optional.  Each is a text string of a multi-dimensional expression (MDX) that evaluates to a  
  member or tuple within the cube.  Alternatively, member_expression can be a set defined with the CUBESET function.  Use member_ 
  expression as a slicer to define the portion of the cube for which the aggregated value is returned.  If no measure is specified in member_ 
  expression, the default measure for that cube is used.

It should be further noted that: 

 • the CUBEVALUE function is supported only when the workbook is connected to a Microsoft SQL Server 2005 Analysis Services or later data  
  source
 • when the CUBEVALUE function evaluates, it temporarily displays a "#GETTING_DATA…" message in the cell before all of the data is retrieved
 • if a cell reference is used for member_expression and that cell reference contains a CUBE function, then member_expression uses the MDX  
  expression for the item in the referenced cell, and not the value displayed in that referenced cell
 • if the connection name is not a valid workbook connection stored in the workbook, CUBEVALUE returns an #NAME? error value.  If the Online  
  Analytical Processing (OLAP) server is not running, not available or returns an error message, CUBEVALUE returns an #NAME? error value
 • if at least one element within the tuple is invalid, CUBEVALUE returns an #VALUE! error value
 • CUBEVALUE returns an #N/A error value when:
   o the member_expression syntax is incorrect
   o the member specified by member_expression doesn't exist in the cube
   o the tuple is invalid because there is no intersection for the specified values (this can occur with multiple elements from the same  
    hierarchy)
   o the set contains at least one member with a different dimension than the other members

The A to Z of Excel Functions: CUBESETCOUNT
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	 •	CUBEVALUE	may	return	an	#N/A	error	value	if	you	reference	a	session-based	object,	such	as	a	calculated	member	or	named	set,	in	a		
	 	 PivotTable	when	sharing	a	connection,	and	that	PivotTable	is	deleted	or	you	convert	the	PivotTable	to	formulae	(on	the	‘Options’	tab	in	the		
	 	 Ribbon,	in	the	‘Tools’	group,	click	‘OLAP	Tools’,	and	then	click	‘Convert	to	Formulas’).

Known issue: null values are converted to zero-length strings

In Excel, if a cell has no data because you never changed it or you deleted the contents, the cell contains an empty value.  In many database systems, 
an empty value is called a null value. An empty or null value literally means "no value".  However, a formula can never return an empty string or 
null value.  A formula always returns one of three values: a number value; a text value (which may be a zero-length string) or an error value, such as 
#NUM! or #VALUE!

If a formula contains a CUBEVALUE function connected to an Online Analytical Processing (OLAP) database and a query to this database results in 
a null value, Excel converts this null value to a zero-length string, even if the formula would otherwise return a number value.  This can lead to a 
situation where a range of cells contain a combination of numeric and zero-length string values, and this situation can affect the results of other 
formulae that reference that range of cells.  For example, if A1 and A3 contain numbers, and A2 contains a formula with a CUBEVALUE function that 
returns a zero-length string, the following formula would return an #VALUE! error:

=A1+A2+A3

To prevent this, you can test for a zero-length string by using the ISTEXT function and by using the IF function to replace the zero-length with a 0 
(zero) as the following example shows:

=IF(ISTEXT(A1),0,A1)+IF(ISTEXT(A2),0,A2)+IF(ISTEXT(A3),0,A3)

Alternatively, you can nest the CUBEVALUE function in an IF condition that returns a zero value if the CUBEVALUE function evaluates to a zero-length 
string as the following example shows:

=IF(CUBEVALUE("Sales","[Measures].[Profit]","[Time].[2020]","[All Product].[Beverages]")="",0, CUBEVALUE("Sales","[Measures].
[Profit]","[Time].[2020]","[All Product].[Beverages]"))

Note that the SUM function does not require this test for a zero-length string because it automatically ignores zero-length strings when calculating 
its return value.

Please see our final examples below: 

=CUBEVALUE("Sales","[Measures].[Profit]","[Time].[2020]","[All Product].[Beverages]")

=CUBEVALUE($A$1,"[Measures].[Profit]",D$12,$A23)

=CUBEVALUE("Sales",$B$7,D$12,$A23).

More Excel Functions next year…

Upcoming SumProduct Training Courses

Location Course Date Duration

Sydney Excel Tips & Tricks 10 Dec 2018 1 Day

Sydney Financial Modelling 11 - 12 Dec 2018 2 Days

Sydney Power Pivot, Power Query and Power BI 17 - 19 Dec 2018 3 Days    

Sydney Power Pivot, Power Query and Power BI 21 - 23 Jan 2019 3 Days

Melbourne Power Pivot, Power Query and Power BI 29 - 31 Jan 2019 3 Days

Sydney Excel Tips & Tricks 4 Feb 2019 1 Day

Sydney Financial Modelling 5 - 6 Feb 2019 2 Days

Brisbane Excel Tips & Tricks 11 Feb 2019 1 Day

Brisbane Financial Modelling 12 - 13 Feb 2019 2 Days

Melbourne Excel Tips & Tricks 19 Feb 2019 1 Day

Melbourne Financial Modelling 20 - 21 Feb 2019 2 Days

Perth Excel Tips & Tricks 25 Feb 2019 1 Day

Perth Financial Modelling 26 - 27 Feb 2019 2 Days

Melbourne Power Pivot, Power Query and Power BI 11 - 13 Mar 2019 3 Days
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Link to Others
These newsletters are not intended to be 
closely guarded secrets.  Please feel free 
to forward this newsletter to anyone you 
think might be interested in converting to 

“the SumProduct way”.

If you have received a forwarded 
newsletter and would like to receive 
future editions automatically, please 

subscribe by completing our newsletter 
registration process found at the foot of 
any www.sumproduct.com web page.

Any Questions?
If you have any tips, comments or queries 
for future newsletters, we’d be delighted 
to hear from you. Please drop us a line at 

newsletter@sumproduct.com.

Our Services
We have undertaken a vast array of 
assignments over the years, including:
·  Business planning
·  Building three-way integrated   
 financial statement projections
·  Independent expert reviews
·  Key driver analysis
·  Model reviews / audits for internal   
 and external purposes
·  M&A work
·  Model scoping
·  Power BI, Power Query & Power Pivot
·  Project finance
·  Real options analysis
·  Refinancing / restructuring
·  Strategic modelling
·  Valuations
·  Working capital management
If you require modelling assistance of any 
kind, please do not hesitate to contact us 
at contact@sumproduct.com.

Training
SumProduct offers a wide range of 
training courses, aimed at finance 
professionals and budding Excel experts. 
Courses include Excel Tricks & Tips, 
Financial Modelling 101, Introduction to 
Forecasting and M&A Modelling. 

Drop us a line at training@sumproduct.com 
for a copy of the brochure or download  
it directly from
http://www.sumproduct.com/training.

Check out our 
more popular 
courses in 
our training 
brochure:

There are over 540 keyboard shortcuts in Excel.  For a comprehensive list, please download our Excel file a
www.sumproduct.com/thought/keyboard-shortcuts. Also, check out our new daily Excel Tip of the Day feature on the 
www.sumproduct.com homepage.

Key Strokes
Each newsletter, we’d like to introduce you to useful keystrokes you may or may not be aware of.  This month, it’s time we took CTRL 
of the function keys

Keystroke What it does

CTRL + F1 Show / hide Ribbon

CTRL + F2 Print

CTRL + F3 Open Name Manager

CTRL + F4 Close Window

CTRL + F5 Restore Window

CTRL + F6 Next Window / Workbook

CTRL + F7 Move Window

CTRL + F8 Size Window

CTRL + F9 Minimise Window

CTRL + F10 Toggle Maximised / Restored

CTRL + F11 Insert New Macro Sheet

CTRL + F12 Open


